3.2.4 Flowsheet is not consistent . . . . . . . . 12
3.2.5 File does not contain a Flowsheet . . . . 12
3.3 Status Bar . . . . . . . . . . . . . . . . . . . . . . 12
  3.3.1 No variable was selected . . . . . . . . . . 12
  3.3.2 No tag was selected . . . . . . . . . . . . 12
  3.3.3 Link disabled: variable and tag are not
       connected . . . . . . . . . . . . . . . . . . . . . . . . . 12
  3.3.4 Variable was not found in flowsheet . . . 13
  3.3.5 Tag could not be read . . . . . . . . . . . . 13
  3.3.6 Tag is read only and can not be written . . 13
Symbols e Conventions

In this document the following notation is considered:

**Note:** a note, for example: nota, por exemplo: As EMSO’s variables are vectors, the vector position is prompted after variable selection. For scalar variables, the vector position must be set as equal to one.

**Warning:** a warning message, for example: When creating a link the flowsheet’s variable and the server’s tag are supposed to have the same units. In cases which it is not true, users must inform conversion parameters.

**Tip:** a tip for users, for example: The main EMSO-OPC Link’s functionalities can be accessed directly trough the command buttons at shortcut bar.

**Linux:** a specific note for the POSIX plataforms, for example: EMSO-OPC Link is currently not available for Linux and Unix systems.

**Windows:** a specific note for the Win32 plataforms, for example: EMSO-OPC Link is currently available for Win9X, WinE, WinXP and Vista systems.
1 Introduction

EMSO-OPC Link is a software application for solving EMSO flowsheets exchanging information with OPC servers. EMSO-OPC Link was developed by VRTech to ALSOC Project. This document is a step by step guide which shows how one can use EMSO-OPC Link in order to run simulations reading and writing on an OPC server. In the third chapter, a troubleshoot is provided.

Contents

1.1 Preliminary Notes .................. 2
  1.1.1 ALSOC Project .................. 2
  1.1.2 EMSO .......................... 2
  1.1.3 OPC .......................... 2
  1.1.4 VRTech ......................... 2
1.2 Overview .......................... 2
1.3 Installation ......................... 3
1 Introduction

1.1 Preliminary Notes

1.1.1 ALSOC Project

ALSOC Project (http://www.enq.ufrgs.br/alsoc/) is an industry-academy approximation effort. Through this project, specifications and software tools are standardized and freely shared between university and consorted companies. ALSOC is a Portuguese language acronym for Free Environment for Process Simulation, Optimization and Control.

1.1.2 EMSO

EMSO, Environment for Modeling, Simulation and Optimization, is the generic dynamics systems simulator developed by the ALSOC project. EMSO has a huge library of process models and also allows its users develop their own models.

1.1.3 OPC

OPC is open connectivity in industrial automation and the enterprise systems that support industry. Based on fundamental standards and technology of the general computing market, the OPC Foundation (http://www.opcfoundation.org) adapts and creates specifications that fill industry-specific needs. There are now hundreds of OPC Data Access servers and clients.

1.1.4 VRTech

VRTech (http://www.vrtech.com.br) is the software development company which developed EMSO-OPC Link for ALSOC.

1.2 Overview

EMSO-OPC Link provides an environment to establish links between OPC tags and variables of an EMSO flowsheet. The application allows users to run simulations using EMSO flowsheets and to access OPC servers for reading and writing data while the simulations are being executed.

The main window of EMSO-OPC Link is presented at Figure 1.1. On the right side of the window there is a Link Tree. On the left side of the window there are three group boxes: Variable Properties, Tag Properties and Output Messages. In variable and tag boxes, EMSO-OPC Link displays information about the link which are currently selected at the tree. In the Output Messages box, EMSO-OPC Link displays messages from EMSO’s engine to
1.3 Installation

Figure 1.1: EMSO-OPC Link’s main window.

users. At the bottom of variable and tag boxes there is the Status Bar which reports information about links functionality.

EMSO-OPC Link is a typical Windows application and it is quite simple to use. All its functionalities can be accessed trough the command menus. Basically, users should load a flowsheet from an EMSO file, establish connections with one or more OPC servers and run process simulations linking server’s tags with flowsheet’s variables.

1.3 Installation

**Linux:** EMSO-OPC Link is currently not available for Linux and Unix systems.

**Windows:** EMSO-OPC Link is currently available for Win9X, WinME, WinXP and Vista systems.
2 Getting Started

In this chapter it is explained how to connect with OPC servers, load EMSO flowsheets, create links and run simulations using EMSO-OPC Link.

Contents

2.1 EOF Projects ................................................. 5
2.2 Establishing Connections with OPC Servers ............ 5
2.3 Loading EMSO’s Flowsheets ............................... 6
2.4 Creating Links ............................................... 6
2.5 Running Simulations ....................................... 8
2.6 Converting Units .......................................... 8
2.1 EOF Projects

When EMSO-OPC Link is opened for the first time, users are prompted to create a new project. EMSO-OPC Link projects are associated EOF files. These files are able to store all information about the links were created while the project was opened. So, before closing a project, users can save it in a EOF file in order to restore his work further. As any typical windows application, EMSO-OPC Link provides a **File** menu with basic file management commands.

2.2 Establishing Connections with OPC Servers

Connections with OPC servers can be established using the connections dialog box. To access this dialog box, one can use the **Connections** command at **Options** menu. The connections dialog is showed at Figure 2.1.

![Connections's dialog box.](image)

On the left side of connections dialog box there is a list of servers connections and on the right side of connections dialog box there is a set of command buttons that allows connections management. Initially, the server list is empty. By clicking the **Add** command button, users are directed to the dialog box showed at Figure 2.2. This dialog box allows users to search servers and to add them to the servers list.

As servers are being added, information about the connection status are displayed on the list. Figure 2.3 shows a list filled with two servers. As it will be showed further, EMSO-OPC Link is able to access tags at OPC servers for reading and writing data.
2.3 Loading EMSO’s Flowsheets

In order to load an EMSO’s file into EMSO-OPC Link, users should click at the Flowsheet command at the Options menu. This command leads to a open file dialog box which similar with Figure 2.4. Users are expected to select a MSO file containing EMSO’s flowsheets. Once a valid file is loaded, a new dialog box similar with Figure 2.5 prompts the users to select a flowsheet.

2.4 Creating Links

After establishing server connections and loading an EMSO flow-sheet, EMSO-OPC Link is able to create links between the flow-sheet’s variables and the server’s tags. New links can be generated by clicking at the Insert Link command at the Options menu. All the links created are stored at the Links Tree. Users can delete or rename a link by using Delete Link or Rename Link commands also at the Options menu.
2.4 Creating Links

Figure 2.4: EMSO’s files selection dialog box.

When it is created a link automatically becomes the current item at the tree and its properties becomes visible at the variables and tag boxes. In order to associate a variable to the link, users must access the variable search dialog. This can be done by clicking on the search variable link on the variable box. Variable search dialog is showed at Figure 2.6.

Note: As EMSO’s variables are vectors, the vector position is prompted after variable selection. For scalar variables, the vector position must be set as equal to one.

The variable selected can be linked with tags from OPC server. By clicking on the search tag link, users can select tags on OPC servers going trough tag search dialog, which is showed at Figure 2.7. The Link drop down menu allows users to activate the links. There are two kind of links: read from tag and write on tag.

Figure 2.5: Flowshet selection dialog box.
2.5 Running Simulations

EMSO-OPC Link can run simulations of EMSO flowsheets. In order to simulate an EMSO flowsheet using EMSO-OPC Link, users must click on the Simulation Run command on the Options menu. If no link is active, EMSO-OPC Link simply simulate the EMSO’s flowsheet. Otherwise, EMSO-OPC Link sets variable and tag values at each simulation step according to active links rules. Simulations can be paused or stopped at any time by clicking on the Pause or Stop commands on the Simulation menu.

2.6 Converting Units

When creating a link the flowsheet’s variable and the server’s tag are supposed to have the same units. In cases which it is not true, users must inform EMSO-OPC Link conversion parameters
2.6 Converting Units

trough the **Units Converter** dialog box, which can be accessed by clicking on **convert units** links. The **Units Converter** dialog box is showed at **Figure 2.8**.

![Units Converter dialog](image)

**Figure 2.8**: Units Converter dialog.

There are two conversion parameters, **A** and **B** and only one basic conversion rule: \([\text{Variable Units}] = [\text{Tag Units}]A + B\). The conversions are carried out by EMSO-OPC Link in such a way that the previous rule is always respected. It does not matter if the application is reading a variable value from a tag value or if the application is writing a tag value from a variable value.

---

**Tip**: The main EMSO-OPC Link’s functionalities can be accessed directly trough the command buttons at shortcut bar.
3 Troubleshoot

This chapter contains a troubleshoot which aims to solve common problems that arise when using EMSO-OPC Link.

Contents

3.1 Loading Errors ................................. 11
   3.1.1 MSO file could not be loaded ............... 11
   3.1.2 Flowsheet could not be found ............... 11
   3.1.3 Could not establish connection with server ...... 11

3.2 Runtime Errors ................................. 11
   3.2.1 No flowsheet selected ....................... 11
   3.2.2 Variable is not a specification in the flowsheet .... 12
   3.2.3 Tag is read only and cannot be written .......... 12
   3.2.4 Flowsheet is not consistent ................. 12
   3.2.5 File does not contain a Flowsheet ............ 12

3.3 Status Bar .......................... 12
   3.3.1 No variable was selected .................. 12
   3.3.2 No tag was selected ....................... 12
   3.3.3 Link disabled: variable and tag are not connected ... 12
   3.3.4 Variable was not found in flowsheet .......... 13
   3.3.5 Tag could not be read ..................... 13
   3.3.6 Tag is read only and cannot be written ........ 13
3.1 Loading Errors

Loading errors are errors that occur when loading an existing EOF project. In this section, most common loading errors and its possible solutions are listed.

3.1.1 MSO file could not be loaded

This error occurs when EMSO-OPC Link can not find the MSO file that was used to generate the EOF project. In those cases, the users receive an error message identifying the missing MSO file that is missing and the EOF project loading is stopped. By experiencing this kind of problems, please be sure that the requested MSO file is still at its original location or if it was not renamed. To solve this problem, provide the requested MSO file to EMSO-OPC Link.

3.1.2 Flowsheet could not be found

This error occurs when EMSO-OPC Link scanned the MSO file and could not find the flowsheet that was used to generate the EOF project. In those cases, the users receive an error message identifying the flowsheet that is missing but the EOF project loading is not stopped. However users will be unable to access variables and to run simulations in those cases. By experiencing this kind of problems, please be sure that the requested flowsheet is still into the MSO file or if it was not renamed. To solve this problem, provide the requested flowsheet file to EMSO-OPC Link.

3.1.3 Could not establish connection with server

This error occurs when EMSO-OPC Link could not connect to the server. In those cases, users are advised to contact the system administrator.

3.2 Runtime Errors

Runtime errors are errors that occur when EMSO-OPC Link is running. In this section, most common runtime errors and its possible solutions are listed.

3.2.1 No flowsheet selected

This error occurs when users try select a variable or start a simulation without having selected a flowsheet before.
3.2.2 Variable is not a specification in the flowsheet

This error occurs when users try to set a non-specification variable to have its value read from a tag. This action is not allowed by EMSO-OPC Link.

3.2.3 Tag is read only and cannot be written

This error occurs when users try to set a variable for writing on a tag which they have only reading access. This action is not allowed by EMSO-OPC Link.

3.2.4 Flowsheet is not consistent

This error occurs when users try to load an inconsistent flowsheet. In those cases, users are advised to run this flowsheet using EMSO to check for errors.

3.2.5 File does not contain a Flowsheet

This error occurs when users try to load an MSO file with no flowsheets.

3.3 Status Bar

The Status Bar continuously reports users about EMSO-OPC Link’s links functionalities. When links are not functional, it displays warning and error messages. In this section, the Status Bar’s messages are presented.

3.3.1 No variable was selected

This warning message means that the link is not ready because no variable was selected. In order to select a variable, click on search variable at the Variable Properties box.

3.3.2 No tag was selected

This warning message means that the link is not ready because no tag was selected. In order to select a tag, click on tag variable at the Tag Properties box.

3.3.3 Link disabled: variable and tag are not connected

This warning message means that variable and tag are properly selected but the link is not active. In order to activate the link, change the Link drop down menu status for read from tag or write on tag.
3.3.4 Variable was not found in flowsheet

This error message means that EMSO-OPC Link scanned the flowsheet file and could not find the indicated variable. By experiencing this kind of problems, please be sure that the indicated variable is still into the flowsheet or if it was not renamed.

3.3.5 Tag could not be read

This error message means that EMSO-OPC Link could not read the indicated tag value. By experiencing this kind of problems, please be sure that the indicated tag and its server are accessible.

3.3.6 Tag is read only and can not be written

This error message means that it was requested to EMSO-OPC Link write on a read only tag. By experiencing this kind of problems, please be sure that the selected tag is correct or contact the system administrator.
Index

EMSO-OPC Link
  description, 2
  Installation, 3
OPC, 2
  description, 2
ALSOB, 2
  description, 2
EMSO, 2
  description, 2
EMSO's Flowsheets, 6
  loading, 6
VRTech, 2
  description, 2
EOF Projects, 5
Errors, 11
  loading errors, 11
  runtime errors, 11
Links, 6
  creating, 6
  selecting tags, 7
  selecting variables, 6
OPC Servers
  description, 5
Simulations, 8
Status Bar, 12
  errors, 12
  warnings, 12
Symbols e Conventions, iii
Units, 8
  Conversion, 8